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0. Introduction
Binic is the first program | distribute through share/freeware canal. | hope you will like it and it will be useful.
This Windows version is a complete rewriting of an old DOS version | wrote in 1991.
If you enjoy and/or use it, please send me a postcard of your home town. If you have time enough, feel free to add any comments, remarks or
suggestions you may find appropriate.
My adress is :
Benoit Marchal
Rue Lucien Naméche, 13
B 5000 Namur
(Belgium)
It is, of course, as useless as expensive to send it by express or plane. Keep it cheap but, please, do write.
This program represents hours of work. It has been carefully tested and checked against bugs and inconstancies. Writing the documentation in
english required a tremendous effort for me.
For all that work, | just ask you a very simple thing : send me a postcard. | just would like to see how far it will go and how many people will use
it.
For sure, | made mistakes. Please be tolerant. As | told you this is a first experiment : things can only improve.
If you don't like it, you may also write to me and tell me why. | may improve only if | know about my mistakes.

1. Installation
Caution ! If you receive Binic as a ZIP archive, you must decompress it with the -d switch to create directories store in archive.

Use the INSTALL program found on the distribution disk to install Binic. INSTALL will place the files into a sub-directory on your hard disk and
add Binic's icon to the Pineapple group of the program manager. All further references to Binic in this file assume you've used INSTALL's default
installation.



To run the installation program from Drive A type :
WIN A:INSTALL
or, if Windows is active, select the program manager's File]Run command and type :
A:INSTALL

validate with the OK button.
Now, just follow instructions given by INSTALL. Normally, all you have to do is choose a directory to copy Binic in and make sure distribution
disk is in your drive.

2. What is Binic ?
Binic is an simple though useful program designed to handle those boring conversions between the various number representation in computer
science : hexadecimal, decimal and binary.
It's rather a programmer tool than an end-user tool.
In addition to immediate translation from one representation to the other, Binic offers some useful services like copy/paste to and from the
clipboard or bit mask to ease manipulation of binary expressed numbers.
Main features of Binic are :
instant translation from one representation to the other for speed
data type management to avoid stupid mistakes
clipboard management which ease importing to and from various editors
bit mask to ease bit manipulations
settings saving.

3. System Requirements
Binic requires Windows 3.0 or higher version, a 80286 CPU or above (i386, i486 or compatible). Windows must run in protected mode.
Binic won't run in real mode or on a 8088/8086 base system.

4. How to use Binic ?

This manual assumes you already know how to perform basic operations with Windows like clicking, selecting an item in a menu,..., that you
are aware of the clipboard,... If it is not the case, please refer to the Windows guides. It also assumes you're having a mouse which is a quite normal
assumption under Windows environment.

Before anything else, we must define a few expressions use in this manual.

The current number is the number you currently edit. This is the number displays in the three edit field of Binic, the one you can change.

The data type is the length (in bit) of the current number. In a computer number are represented by a various number of bit. 8 bits are called an
octet, 16 bits are a word (at least on PC) and 32 bits are a double word. On an octet, you can code 256 different numbers, more on a word or on a
double word. A number can also be signed or unsigned. This is also part of the data type.

Example : 90 in hexadecimal is 144 in decimal if coded as an unsigned byte, -112 if coded as a signed byte and 144 if coded as a word or double
word (signed or unsigned). Binic can automatically handles those differences. This can ease some manipulations.

A switch option is an option which can be active (or on) or inactive (or off). I.e. two mutually exclusives states.



To start Binic just double click on its icon in the program manager. Binic main window displays. It should look like this :

Note that actual colors may vary depending on your system.
To enter a number, just select the appropriate field by clicking on it with the left button of your mouse or by using keyboard shortcuts :
Al+H : hexadecimal
Alt+D : decimal
Alt+B : binary,
and type the number of your choice. Note that while you enter a number in a field, other field are immediately adapted according to change.
Example : select the hexadecimal field by clicking anywhere on it, now type 59 (l.e. 89 in decimal), decimal field is now 89 and binary field
0000000001011001, reflecting the new value you entered. As you can see, adaptation is immediate.
Note : actual number of 0 in binary field may vary decimal value may be different depending on the current data type. Don't mind, you'll quickly learn
how to change this.

Quick change

:

Quick change's buttons are a easy way to increment or decrement current number. The "+" button add 1 to the number, the "-" button substract
one from the number.
Example : now, click on the "+" button, number change to 90 in decimal, I.e. 5A in hexadecimal or 0000000001011010 in binary.

And now the secrets of the menus.

Edit
Copy... Ctri+C
Paste... Ctri+¥
Clear Ctrl+Del
Bit mask...
Exit Alt+x

The edit menu offers the following commands :
Copy : copy number representation to the clipboard, you're prompted to know which representation you want to copy.



Paste : paste number representation from the clipboard, you're prompted to know in which representation is the number in the clipboard. If no data
are available in the clipboard, this item is grayed.
Combining these two commands, you can easily import a number in one representation (say decimal) from your text editor, convert it into binary
representation and copy it back to your text editor.
Clear : just set to zero current number.
Bit mask : display bit mask. Bit mask is a convenient way to set or unset a particular bit. Bit mask dialog box looks like this :

Actual Bit mask dialog box may vary on your system, according to the data type you use. Don't mind, you'll quickly learn how to change data type.
There is a check box by bit of the current number. When the bit's value is 1, associated check box is checked, when bit's value is 0, associated check
box is unchecked.

You can quickly change a bit value by checking or unchecking it's corresponding check box.

Example : to set bit 5, click on Bit 5 check box, validate with OK button. Current number is now 0000000001111010 (l.e. bit 5 is 1) or 122 in decimal
or 7A in hexadecimal. As usual, number modification is immediately reported to all three representations.

This is easier than having to count 4 digits before typing 1 in the binary field but otherwise it is the same. This feature is particularly pleasant with long
data type like double word (32 bits).

Exit : as you've probably already understood, this item is use to exit Binic. Don't try it now, there are still some features of Binic to discover.

Note : keyboard short cut in this menu are the new ones, Mac-like, as use by Microsoft in Windows 3.1. But the old ones (Shift+Del, Ctrl+Ins &
Shift+ins) are still available.

Format
+ Signed

Unsigned

Byte
+ Word
Double word

As promise here is how to select data type. The Format menu is where you do this : byte, word or double word, signed or unsigned.

The items are divided in 2 groups :
Signed/Unsigned : to choose whether data type is signed or not
Byte/Word/Double word : to choose the size of the internal representation of data type.

In each group, items are mutually exclusive l.e. only one item at a time can be selected. The currently selected item is shown by a check mark
(\) beside it.

When you select an item in a group, the currently selected one of that group is automatically deselected.



Note that with the current version of Binic (2.0.0), you can't select an unsigned double word. So Signed and Unsigned items are grayed when
you select Double word and Double word is grayed when you choose unsigned.

Options
+ Confirm exit

Save settings now
Save settings on exit

The Options menu offers the following item :
Confirm exit : this is a switch option, when on you're prompted for confirmation before leaving Binic. When this option is on, a check mark (V) appears
beside the item.
The following items concern saving of Binic's settings. Binic can save it's current settings when asked.
When it reopens, Binic reads those settings and set himself according to them as if you select them in the menus. This feature allows you to
gain time.
The settings Binic can save are :
confirmation of exit (see below)
automatic save of settings on exit (see below)
data type.
Now let's have a look at those famous commands :
Save settings now : this command save current settings of Binic at the time you select it.
Save settings on exit : this option ask Binic to automatically save current settings when you exit. It is equivalent to select Save settings on exit just
before closing Binic. This is a switch option. When this option is on, a check mark (v) appears beside the item.
When you turn this option off, you're prompted to save it.

This is logical : because Binic will no longer save settings on exit so if you don't explicitly save settings, the next time you'll load Binic, he will have
forget this.

Be careful, if you choose Yes Binic will only remember to no longer save settings on exit, this doesn't save any other setting (like data type). This
dialog box is not equivalent to Save settings now command !

About Pineapple Binic...

The last command displays the About dialog box where you can find copyright and version informations.

5. Advanced features



So far you've learn everything about Binic commands. You should be able to convert a number from one representation to another and to use
the clipboard for quick and safe data exchange from or to you favorite text editor.

In this section, we'll have a look at some "advanced features" of Binic design to ease its manipulation. This means the local menus.

Local menus are menus attached to an edit field. They offers options suited for the particular field you selected. To open a local menu, simply
click with the right button on an edit field.

Decimal

Suppose you open Decimal edit field local menu by clicking with the right button anywhere on the Decimal edit field, a popup menu with 2
options (Copy & Paste) appears.

Be sure to click inside the rectangle which limit the edit field. Not above or around. Be sure you use the right button of your mouse (or left
button if you inverted mouse button).
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With this menu you can simply copy edit field's content to the clipboard or paste clipboard content into the edit field.
On a way, this is similar to the Copy and Paste command of the Edit menu. But easier and quicker : here you don't have to specified which
representation you're working on. Since you open Decimal local menu, Binic understand you want to manipulate decimal representation.



Hexadecimal
007A

Hexadecimal local menu is similar to decimal one : it offers the same options but, off course, it copy/paste hexadecimal representation of
current number.

Binary

0000000001111010N
Copy —

Paste

Bit mask...

Binary local menu offers the Copy/Paste commands we already know (and this time, they work on binary representation of current number).
But there's an extra command : Bit mask. This open bit mask you already use. This command is strictly equivallent to Edit|Bit mask command.

6. Future improvements

Many things must be improve in Binic. This chapter intend to explain you the main changes | planned for Binic. Feel free to comment this.

The most important lack, | think, is the lack of unsigned double word. This is due to the language | used to program Binic : Turbo Pascal doesn't
know anything about unsigned double word. As long as | was the only user of Binic, it wasn't a big problem but now that | consider distribution, | will
fix it in further release.

| also plan to change the save settings option to to automatically save changes in this menu. The original idea was : Binic won't save something
on it's own when you've just ask him to no longer save things automatically. Through experiment, | found it is an useless complexity. This will be fix in
next release.

It should also save the position of the window when it was close so that you won't have to reposition it every time you start it. This will also be
fix in further release.

Finally, | may write an help file.

If you like Binic please support those improvement by sending me a postcard (to encourage me) as describe in the introduction.
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8. Legal matters

Binic is © 1991-1993 by benoit marchal. All rights reserved.

Binic is distributed "as is" l.e. without any guaranty implicit or explicit.

Though Binic has been carefully developed and tested, some problems may still occur. You assume the responsibility for using Binic. If
something went wrong, you have all my sympathy but nothing else.

You are granted the right to use the current release Binic, make copies for backup purpose and distribute it as long as unmodified and complete
(including full documentation).

If require, you may charge some fee to cover distribution costs provided it is made clear to the customer that he didn't pay for Binic. Those fees
may not exceed 10$.

If you like (or even dislike) and/or use Binic, please send me a postcard with comment, remarks or suggestion. See introduction.



